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[bookmark: _Toc51216003]Purpose
The Kanban method for controlling production and material flow is based on the actual stock quantity in production. Material that is required on a regular basis is continually provided in small quantities into production. With Kanban, instead of being pushed through production by higher-level planning, materials are called from the supply source by production at the manufacturing level where they are needed (pull principle). Replenishment or production of a material is only triggered when a higher production level requires the material. This replenishment is triggered directly in production using previously maintained master data.
Kanban replenishment is commonly used in - but not restricted to - repetitive manufacturing environments, when a production process requires that the same or similar products are produced over a certain period at a certain rate per period. The products produced always follow the same sequence through the machines and work centers in production. Routings tend to be simple and do not vary much.
This document provides a detailed procedure for testing this scope item after solution activation, reflecting the predefined scope of the solution. Each process step, report, or item is covered in its own section, providing the system interactions (test steps) in a table view. Steps that are not in scope of the process but are needed for testing are marked accordingly. Project-specific steps must be added.
[bookmark: unique_2][bookmark: _Toc51216004]Prerequisites
This section summarizes all the prerequisites for conducting the test in terms of systems, users, master data, organizational data, other test data and business conditions.
[bookmark: unique_3][bookmark: _Toc51216005]System Access
	System
	Details

	System
	Accessible via SAP Fiori launchpad. Your system administrator provides you with the URL to access the various apps assigned to your role.


[bookmark: unique_4][bookmark: _Toc51216006]Roles
Assign the following business roles to your individual test users. Alternatively, if available, you can create business roles using the following spaces with pages and predefined apps for the SAP Fiori launchpad and assign the business roles to your individual test users.
Note These roles or spaces are examples provided by SAP. You can use them as templates to create your own roles or spaces.
For more information about business roles, refer to Assigning business roles to a user in the Administration Guide to Implementation of SAP S/4HANA with SAP Best Practices .
	Name (Role)
	ID (Role)
	Description (Space)
	ID (Space)
	Log On

	Production Planner
	SAP_BR_PRODN_PLNR
	Production Planning
	SAP_BR_PRODN_PLNR
	

	Production Supervisor - Repetitive Manufacturing
	SAP_BR_PRODN_SUPERVISOR_RPTV
	Production Control
	SAP_BR_PRODN_SUPERVISOR_RPTV
	

	Production Planner - Lean Manufacturing
	SAP_BR_PRODN_PLNR_LEAN_MFG
	Lean Manufacturing Planning
	SAP_BR_PRODN_PLNR_LEAN_MFG
	

	Production Operator - Repetitive Manufacturing
	SAP_BR_PRODN_OPTR_RPTV
	Production Execution
	SAP_BR_PRODN_OPTR_RPTV
	

	Production Operator - Lean Manufacturing
	SAP_BR_PRODN_OPTR_LEAN_MFG
	Lean Manufacturing Operations
	SAP_BR_PRODN_OPTR_LEAN_MFG
	

	Production Operator - Discrete Manufacturing
	SAP_BR_PRODN_OPTR_DISC
	Discrete Manufacturing Execution
	SAP_BR_PRODN_OPTR_DISC
	

	Warehouse Clerk
	SAP_BR_WAREHOUSE_CLERK
	Inventory Processing
	SAP_BR_WAREHOUSE_CLERK
	

	Cost Accountant - Production
	SAP_BR_PRODN_ACCOUNTANT
	Product Costing
	SAP_BR_PRODN_ACCOUNTANT
	

	Inventory Manager
	SAP_BR_INVENTORY_MANAGER
	Inventory Management
	SAP_BR_INVENTORY_MANAGER
	

	Purchaser
	SAP_BR_PURCHASER
	Operational Purchasing
	SAP_BR_PURCHASER
	


[bookmark: unique_5][bookmark: _Toc51216007]Master Data, Organizational Data, and Other Data
The organizational structure and master data of your company is created in your system during activation. The organizational structure reflects the structure of your company. The master data represents materials, customers, and vendors, for example, depending on the operational focus of your company.
Use your own master data to go through the test procedure:
	Master
	Value
	Details
	Comments

	Material
	FG233
	
	

	Material
	SG234
	
	

	Material
	SG233
	
	

	Material
	RM234
	
	

	Material
	RM233-1
	
	

	Material
	RM233-2
	
	

	Material
	RM233-4
	
	

	Material
	RM235
	
	

	Vendor
	10300002
	Domestic 10 Supplier 2
	
	

	Plant
	1010
	Plant 1 DE
	

	Storage Location
	101A
	Std. storage 1
	

	Storage Location
	101B
	Std. storage 2
	

	Storage Location
	101C
	Raw mat. sto. loc.
	

	Storage Location
	101E
	Kanban
	


Bill of Material Structure
This overview shows the bill of material structure and the usage of each component if you have activated all optional enhancements.
	Material
	Level
	Material Type
	Unit
	Characteristic of Material
	Optional Enhancements

	FG233
	0
	FERT
	PC
	
	

	SG234
	1
	SEMI
	PC
	
	

	RM235
	2
	RAW
	PC
	
	

	SG233
	1
	SEMI
	PC
	
	

	RM234
	2
	RAW
	PC
	
	

	RM233-1
	1
	RAW
	PC
	
	

	RM233-2
	1
	RAW
	PC
	
	

	RM233-4
	1
	RAW
	PC
	
	


For more information about creating master data objects, see the following Master Data Scripts (MDS)
Table 1: Master Data Script Reference
	Master Data ID
	Description

	BNT
	Create Product Master of Type "Finished Good"

	BNS
	Create Product Master of Type "Semi-Finished Good"

	BNR
	Create Product Master of Type "Raw Material"

	BNE
	Create Supplier Master

	40D
	Create Production Supply Area

	BNJ
	Create Production Work Center

	BNK
	Create Material BOM for Production and Sales

	BNL
	Create Routing

	BLD
	Create Production Version


[bookmark: unique_6][bookmark: _Toc51216008]Business Conditions
Before this scope item can be tested, the following business condition must be met.
	Scope Item
	Business Condition

	BNU - Create Costing Run
	You have completed the steps described in this master data script.

	BEG - Standard Cost Calculation
	You have completed the step described in the Test Script BEG.


[bookmark: unique_7][bookmark: _Toc51216009]Preliminary Steps
This Business Process Documentation contains process steps that must be completed before you can start to work through the standard Business Process Documentation of selected logistics scenarios.
[bookmark: unique_8][bookmark: _Toc51216010]Create Info Record
Procedure
If the info record for the material RM233-2, RM233-4 and supplier 10300002 already exist in the system, you can skip this step. Otherwise, you need to create info record for each material or supplier pair.

	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Comments

	1
	Log On
	Log on to the SAP Fiori launchpad as a Purchaser.
	The SAP Fiori launchpad displays.
	

	2
	Access the App
	Open Create Purchasing Info Record (ME11).
	The Create Info Record: Initial Screen displays.
	

	3
	Enter Initial Data
	Make the following entries and press Enter:
1. Supplier: 10300002
· Material: <Material>
· Purchasing Org.: 1010
· Plant: 1010
Select the Standard checkbox, then press Enter.
	The Create Info Record: General Data screen displays.
	

	4
	Choose Purch.Org.Data 1
	Choose Purch.Org.Data 1.
	The Create Info Record: Purch. Organization Data 1 screen displays.
	

	5
	Enter Item Data
	Enter the following values:
1. Pl. Deliv. Time: <X Day>
· Purch.Group: 001
· Tol. Underdl.: <XX%>
· Tol. Overdl.: <XX%>
· Standard Qty: <100>
· Net Price: <3.75>
· Price unit: <1 pc>
· Tax Code: V0
· TxValidFrm: <01/01/1900, choose via F4 HELP>
Press Enter.
	
	

	6
	Save
	Choose Save.
	A purchasing info record for consigned procurement is saved.
	


[bookmark: unique_9][bookmark: _Toc51216011]Create Scheduling Agreement
Purpose
This activity is used to create the scheduling agreement for the material and supplier combination. For example, material RM233-4 and supplier 10300002, directly or without reference to any preceding purchasing documents like Purchase Requisition, if it has not been maintained yet.
If the scheduling agreement is already present in the system, then feel free to skip this step.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as a Purchaser.
	The SAP Fiori launchpad displays.
	

	2
	Access the App
	Open Manage Purchase Scheduling Agreements .
	
	

	3
	Create Scheduling Agreement
	Select Create to create a new scheduling agreement.
	
	

	4
	Enter Header Data
	Create a new scheduling agreement with the following data:
1. Supplier: 10300002
· Agreement type: LPA (SA With Release doc.)
· Valid From: <today>
· Valid To: <MM/DD/YYYY>, for example, today + 720 day
· Purchasing Group: 001
· Purchasing Organization: 1010
	
	

	5
	Add Items to Scheduling Agreement
	From the New Scheduling Agreement view, choose the Items facets and select Create.
	The New Scheduling Agreement Item view displays.
	

	6
	Enter Item Data
	On the Items facets view, make the following entries:
In the General Information view
1. Plant: 1010
· Material: RM233-4
In the Quantity and Price view
1. Target Quantity: 10000
· Net Order Price: <Defaulted from Info record>
In the GR/IR Control view
1. Kanban Indicator: Y (Scheduling Agreement for Summarized JIT Call)
In the Output Control view,
1. JIT Indicator: 1(Automatically)
Choose Apply at the bottom of the view.
	
	

	7
	Save
	Return to the New Scheduling Agreement header view and choose Save at the bottom of the view.
Make a note of the schedule agreement number.
	A schedule agreement is created.
	


[bookmark: unique_10][bookmark: _Toc51216012]Manage Source List
Purpose
This process step shows you how to maintain the contract as the source.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as a Purchaser.
	The SAP Fiori launchpad displays.
	

	2
	Access the App
	Open Manage Source Lists (F1859).
	
	

	3
	Maintain the Filter of Source List
	In the filter, make the following entries:
1. Material: RM233-4
· Plant: 1010
Then choose Go.
	
	

	4
	Check the Source List
	If there is one item that valid in the period, ignore the following steps, if it doesn’t have one item, then continue.
	
	

	5
	Create Source List
	Choose Create Object (+).
	The Source List screen is displayed.
	

	6
	Enter the Detail data
	Enter the values in the following fields:
1. Material: RM233-4
· Plant: 1010
Then choose Generate.
	
	

	7
	Generate Source List
	In the new line appeared under Source Lists area, enter following parameters and choose Enter:
1. Valid From: for example, <today>
· Valid to: for example, <end of next year>
· Agreement: scheduling agreement that created in the previous preliminary step Create Scheduling Agreement section
· Agreement Item: agreement item created before, for example, <10>
	
	

	8
	Maintain Parameters
	Choose the created source list, on the General Information screen,
1. Materials Planning: 2
Choose Apply.
	
	

	9
	Save the Source List
	Choose Save.
	The source list is saved.
	


[bookmark: unique_11][bookmark: _Toc51216013]Create Product Cost Collectors
Purpose
This step can only be executed if product cost planning is activated.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as a Cost Accountant - Production.
	The SAP Fiori launchpad displays.
	

	2
	Access the App
	Open Create Product Cost Collectors - Production Versions - Collective (KKF6M).
	The Create Multiple Product Cost Collector for Production Versions screen displays.
	

	3
	Enter Relevant Values
	Make the following entries and choose Execute.
1. Plant: 1010
· Order Type: YBMR
· Only Repetitive Mfg Mat.: <select>
Caution Once the product cost collector is created, it can't be created again with the same data.
	
	

	4
	Select Production Versions
	The Select Production Versions screen could display if there is more than one production version or more than one material.
	The Select Production Versions screen may display if there is more than one production version or more than one material.
	

	5
	Save
	Select the row for the production version of materials FG233 and SG233. Choose Save.
	The message log displays.
	

	6
	Exit
	Choose Exit.
	
	


[bookmark: unique_12][bookmark: _Toc51216014]Create Preliminary Cost for the Product Cost Collectors
Purpose
In this topic, you create preliminary costs for the product cost collectors.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as a Cost Accountant - Production.
	The SAP Fiori launchpad displays.
	

	2
	Access the App
	Open Create Preliminary Cost Estimate - Product Cost Collectors (MF30).
	The Creation of Preliminary Cost Estimates For Product Cost Collectors screen displays.
	

	3
	Enter Relevant Values
	Make the following entries and choose Execute.
1. Costing Date : <Current Date>
· Plant: 1010
	
	


[bookmark: unique_13][bookmark: _Toc51216015]Maintain Output Control for Kanban Summarized JIT Call
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad an Administrator.
	The SAP Fiori launchpad displays.
	

	2
	Access the App (for Cloud system)
	Open Output Parameter Determination .
	
	

	3
	Access the Customizing Path (for on-premise system)
	For SAP S/4HANA on-premise system, access IMG activity IMG > Cross-Application Components > Output Control > Define Business Rules for Output Determination .
Transaction Code: OPD.
Note Please check and make sure Output Control for Summarized JIT Call is activated. Access IMG activity IMG > Cross-Application Components > Output Control > Manage Application Object Type Activation , you should see following entry:
1. Application Object Type: SUMMARIZED_JIT_CALL
Status: Application Active
	
	

	4
	Choose Show Rules for
	On the Show Rules for field, choose the triangle button and choose Summarized JIT Call from the dropdown list.
	
	

	5
	Choose the Determination Step and Maintain Table Contents
	On the Determination Step Field, choose the triangle button.
Choose Channel, and maintain the following entry in Table Contents.
Entry 1 as below:
1. Output type: SUMMARIZED_JIT_CALL (Summarized JIT Call)
· Role: LF
· Channel: PRINT (Printout)
· Exclusive Indicator: – (false)
Choose Printer Settings, and maintain the following entry in Table Contents.
Entry 1 as below:
1. Output type: SUMMARIZED_JIT_CALL (Summarized JIT Call)
· Role: LF
· Print Queue: <your queue>
· Number of Copies: 1
To maintain Table Contents.
1. Choose Edit on Output Parameter Determination.
1. Choose Insert New Row if a new row has to be added.
2. Choose the triangle button on the field to be maintained.
3. Choose Direct Value Input on the dropdown list.
4. Input the value.
5. Choose Activate, on the popup screen choose yes to save.
6. Choose Display.
	
	


[bookmark: unique_14][bookmark: _Toc51216016]Create Control Cycle for External Kanban Processing
Purpose
In this step, you create a control cycle for classic Kanban that can be used for external procurement with scheduling agreements. In the control cycle, you define the demand source, the supply source and the procedure that must be used to replenish the Kanban material. You also define the number of Kanbans that circulate among the supply source and the demand source, as well as the quantity a Kanban contains.
[bookmark: unique_15][bookmark: _Toc51216017]Control Cycle for Classic Kanban: External Processing with Requirements Planning
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log on
	Log on to the SAP Fiori Launchpad as a Production Planner - Lean Manufacturing.
	The SAP Fiori Launchpad displays.
	

	2
	Access the App
	Open Manage Kanban Control Cycles (PKMC).
	The Manage Kanban Control Cycles (PKMC) displays.
	

	3
	Navigate to Create Control Cycle Screen
	Make the following entries and choose Display/Change.
Plant: 1010
Choose Create Control Cycle.
	The Create Control Cycle screen displays.
	

	4
	Enter the selection details
	Make the following entries and choose Continue:
1. Classic KANBAN: Selected
· Material: RM233-4
· Prodn Supply Area: KANBAN_01
· Lifecycle status: Released
	The Control Cycle Maintenance: Change screen displays.
	

	5
	Enter the Control Cycle Details
	Make the following entries:
1. Number of Containers: 2
· Container Quantity: 200
· Maximum Empty Containers: 1
· Number of Load Carriers: 0
· Replenishment Strategy: Select External Procurement: Enter the value PDA7 and choose Enter. The tab changes title from Replenishment strategy to External Procurement.
· Agreement.:The Scheduling Agreement you created in previous step
· Item Value: 10
· Flow Control
· JIT Call Prof.: PD01
· Kanban Calculation.
· Calc. Type: 1
· Calc. Profile: PD01
· Print Control
· Print Queue: KANBAN_PRINT
	The Purchasing Org and Vendor fields are automatically filled by the system when the Agreement number is entered.
	

	6
	Save
	Choose Save Control Cycle.
	You have created an external Kanban control cycle for material RM233-4.
	


[bookmark: unique_16][bookmark: _Toc51216018]Control Cycle for Event-driven Kanban: External Processing with Purchase Order
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as a Production Planner - Lean Manufacturing.
	The SAP Fiori launchpad displays.
	

	2
	Access the App
	Open Manage Kanban Control Cycles (PKMC).
	The Manage Kanban Control Cycles (PKMC) displays.
	

	3
	Navigate to Create Control Cycle Screen
	Make the following entries and choose Display/Change.
1. Plant: 1010
Choose Create Control Cycle.
	The Create Control Cycle screen displays.
	

	4
	Enter the Selection Details
	Make the following entries and choose Continue:
1. Event-driven Kanban: Selected
· Material: RM233-2
· Prodn Supply Area: KANBAN_04
· Lifecycle status: Released
	The Control Cycle Maintenance: Change screen displays.
	

	5
	Enter the Control Cycle Details
	Make the following entries:
1. Container Quantity: 100
· Replenishment Strategy: Select External Procurement: Enter the value PD01 and choose Enter.
The tab changes title from Replenishment strategy to External Procurement.
1. Purchasing Org: 1010
· Vendor : 10300002
· Print Control
· Print Card: 1
· Output Device: <your output device> for example: LOCL
	
	

	6
	Save
	Choose Save Control Cycle.
	You created an external Kanban control cycle for material RM233-2.
	


[bookmark: unique_17][bookmark: _Toc51216019]Initialize Material Stock
Purpose
This step describes standard purchasing process. But in real business cases, raw materials are usually purchased from external vendors.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as an Inventory Manager.
	The SAP Fiori launchpad displays.
	

	2
	Access the App
	Open Manage Stock (F1062).
	The Manage Stock (F1062) screen displays.
	

	3
	Input Material
	Make the following entries and press Enter:
1. Material:If you want to execute the whole production process for finished goods FG233, you can post initial stock for other necessary components, for example, RM234, RM233-1, SG234, SG233.
· Plant: Plant 1 DE1010
	The stock overview for the material displays.
	

	4
	Select Stock
	Select the icon next to the stock where you want to add initial stock.
For example:
1. Storage Location: 101B
· Unrestricted Use Stock
	In a dialog box, the Storage Location, Stock Type and Current Quantity fields display per your entries in previous steps.
	

	5
	Add Initial Entry
	Make the following entries and choose Post:
1. Document Date: <Today>
· Posting Date: <Today>
· Stock Change: Initial Entry
· Quantity: <Enter a quantity>
	
	


[bookmark: unique_18][bookmark: _Toc51216020]Overview Table
This scope item consists of several process steps provided in the table below.
If your system administrator has enabled spaces and pages on the SAP Fiori launchpad, the homepage will only contain the essential apps for performing the typical tasks of a business role.
You can find all other apps not included on the homepage using the search bar.
If you want to personalize the homepage and include the hidden apps, navigate to your user profile and choose Settings > App Finder .
	Process Step
	Business Role
	Transaction/APPs
	Expected Results

	Anonymous Forecast and MRP

	Create Planned Independent Requirements  [page ] 22
	Production Planner
	Maintain PIRs (F3445)
	

	Material Requirements Planning  [page ] 24
	Production Planner
	Schedule MRP Runs (F1339)
	

	Adjust Planning in Planning Table  [page ] 25
	Production Supervisor - Repetitive Manufacturing
	Manage Repetitive Manufacturing (MF50)
	

	Production-Supply by Changing Kanban Container Status and Using Kanban Board

	Classic Kanban: External Procurement with Requirements Planning

	Check Dependent Requirement of Material RM233-4  [page ] 27
	Production Planner
	Monitor Material Coverage (obsolete) - Net Segments (F0247)
	

	Release Scheduling Agreement  [page ] 29
	Purchaser
	Manage Purchase Scheduling Agreements (F2179)
	

	Set Available Kanban to EMPTY  [page ] 30
	Production Operator - Lean Manufacturing
	Set Kanban Container Status (F3717)
	

	Posting the Goods Receipt for External Procurement

	Option A: Change the Kanban to FULL  [page ] 33
	Production Operator - Lean Manufacturing
	Set Kanban Container Status (F3717)
	

	Option B: Goods Receipt for JIT Call  [page ] 34
	Production Operator - Lean Manufacturing
	Goods Receipt for JIT Call (PJWE)
	

	Precalculation of Kanbans for Future Requirements  [page ] 36
	Production Planner - Lean Manufacturing
	Kanban Calculation (PK07)
	

	Release Proposal of Kanbans Required for Future Period  [page ] 37
	Production Planner - Lean Manufacturing
	Check Kanban Calculation Result (PK08N)
	

	Check Changes and Calculation Base in Control Cycle  [page ] 38
	Production Planner - Lean Manufacturing
	Manage Kanban Control Cycles (PKMC)
	

	Unlock New Kanbans  [page ] 40
	Production Planner - Lean Manufacturing
	Unlock Kanban Container (PK09)
	

	Alert for Delayed Replenishments - Creation of Replenishment Elements / JIT Calls (Optional)  [page ] 41
	Production Planner - Lean Manufacturing
	Display Kanbans: Demand View (PK13N)
	

	Alert for Delayed Replenishments - Evaluation of Replenishment Elements / JIT Calls (Optional)  [page ] 43
	Production Planner - Lean Manufacturing
	Due Kanban Replenishment Elements (PKAL)
	

	Event-driven Kanban: External Processing and PDF Print of Kanban Card

	Create Event-Driven Kanban  [page ] 45
	Production Planner - Lean Manufacturing
	Display Kanbans: Demand View (PK13N)
	

	Variant 1: Set Kanban to FULL  [page ] 46
	Production Operator - Lean Manufacturing
	Set Kanban Container Status (F3717)
	

	Variant 2: Goods Receipt  [page ] 48
	Warehouse Clerk
	Post Goods Receipt for Purchasing Document (F0843)
	

	Set Available Kanban to EMPTY  [page ] 49
	Production Operator - Lean Manufacturing
	Set Kanban Container Status (F3717)
	

	Repetitive Manufacturing Backflush  [page ] 51
	Production Operator - Repetitive Manufacturing
	Confirm Repetitive Manufacturing (MFBF)
	

	Post Processing List of Error Records  [page ] 53
	Production Operator - Repetitive Manufacturing
	Reprocess Goods Movements (COGI)
	

	Review Manufacturing Object Pages  [page ] 54
	Production Planner
	Search
	


[bookmark: unique_40][bookmark: _Toc51216021]Test Procedures
This section describes test procedures for each process step that belongs to this scope item.
[bookmark: d2e2070][bookmark: _Toc51216022]Anonymous Forecast and MRP
[bookmark: unique_19][bookmark: _Toc51216023]Create Planned Independent Requirements
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
Planned Independent Requirements (PIRs) are used to perform demand management functions. A planned independent requirement contains one planned quantity and one date, or a number of planned independent requirements schedule lines, that is, splitting one planned quantity according to dates.
Note Instead of creating a single requirement, sometimes a requirement plan that includes one or more planned independent requirements can be maintained for mass processing. In this case, the requirements are grouped and maintained under a requirement plan number.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as a Production Planner.
	The SAP Fiori launchpad displays.
	

	2
	Access the App
	Open Maintain PIRs (F3445).
	
	

	3
	Check Default Area of Responsibility
	On the Maintain PIRs screen, choose your user name and choose the App Settings icon. On the MRP Settings, screen, choose Area of Responsibility and check if only the following entry is assigned:
1. Plant 1 DE (1010)
· MRP Controller 001(001)
Choose AOR status button of this entry if not assigned, choose AOR status button of the corresponding entry to unassign any other entry then choose Back.
	
	

	4
	Select
	On the Maintain PIRs screen, make the following entries:
1. Plant: 1010
· Period Indicator: Weekly (W)
· Version Active: Yes,No
· Search: FG233
	
	

	5
	Filter Result
	Choose Go to execute.
	Material item displays.
	

	6
	Select Material Item
	Check the material item and choose Edit on the upper right side of the screen.
	
	

	7
	Edit PIRs
	On the screen, enter quantities per period, for example:
1. PIR: 100
And make sure the version is active.
1. Version is active: YES
	
	

	8
	Save PIRs Draft
	Choose Save at bottom right.
	The PIRs are saved.
	


[bookmark: unique_20][bookmark: _Toc51216024]Material Requirements Planning
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
The aim of material requirements planning is to tailor available capacities and receipts on time to suit requirements quantities. You can use MRP or consumption-based planning for this purpose. Single-item multi-level requirement planning is performed for plant 1010.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as a Production Planner.
	The SAP Fiori launchpad displays.
	

	2
	Access the App
	Open Schedule MRP Runs (F1339).
	The Application Jobs screen displays.
	

	3
	Create New Job
	Choose Create.
On the New Job screen, make the following entries:
For 1. Template Selection section:
1. Job Template: Material Requirement Planning (MRP)
· Job Name: <MRP for FG233>
Choose Step 2.
For 2. Scheduling Options section:
1. Start Immediately: <select>
Choose Define Recurrence Pattern.
On the Scheduling Information screen, make the following entries:
1. Start Immediately: X
· Recurrence Pattern: Single Run
Choose OK.
Choose Step 3.
For 3 Parameters section:
1. Plant: 1010
· Material: MRP for FG233
· Changed BOM Components: select
· Planning Mode: 1
Choose Check at the bottom right.
Choose Schedule.
	A message appears: You can go ahead and schedule the job.
	

	4
	Refresh Application Jobs List
	To check the job’s status, enter MRP for FG233 in the search box and choose Go at the top right section of the screen.
	The new job is created and is displayed in the Application Jobs table when refreshed.
	


[bookmark: unique_21][bookmark: _Toc51216025]Adjust Planning in Planning Table
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
This process step shows you how to plan the production of materials on the production lines.
Prerequisite
Requirements planning is performed.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as a Production Supervisor - Repetitive Manufacturing.
	The SAP Fiori launchpad displays.
	

	2
	Access the App
	Open Manage Repetitive Manufacturing (MF50).
	The Planning Table Initial Screen: Change Mode screen displays.
	

	3
	Enter Details
	Make the following entries and choose Execute.
1. Material: FG233
· Plant: 1010
	The Planning Table For Repetitive Manufacturing: Change Model screen displays.
	

	4
	Change the Quantity
	Change any planned quantities in row 0001 WINDING.
	If you want to change the periods in the Planning table, choose More > View > Period > Week (Month or Day) .
	

	5
	Save
	Choose Save.
Confirm any warning notifications for Storage Locations.
	Material production is planned on production lines and the planned orders are fixed. When there are quantity changes, log on to the SAP Fiori launchpad as a Production Planner, open Monitor Material Coverage - Net Segments to check the planned order number.
	


[bookmark: unique_41][bookmark: _Toc51216026]Production-Supply by Changing Kanban Container Status and Using Kanban Board
Kanban board is one of the tools that can be used to change the container status, which can provide both demand source (consumer) and supply source (supplier, producer) with a detailed overview of Kanban circulation. In addition, Material Replenishment could be quickly triggered by setting Kanban container status.
[bookmark: unique_42][bookmark: _Toc51216027]Classic Kanban: External Procurement with Requirements Planning
Purpose
You can perform the automatic Kanban calculation. The system calculates on the basis of existing requirements and your specified calculation parameters, either the number of Kanban containers (cards) that are to circulate in a control cycle or the quantity of material to be procured per Kanban container.
With the number of Kanban containers and the quantity of material per container, the material circulation and the stock of material in the control cycle are defined. To ensure the lowest possible stock of material while simultaneously achieving a secure material supply, the setting of these two values must be optimized. Because the requirement situation often fluctuates considerably in many industries, it is necessary to check and adjust these values with the automatic Kanban calculation on a regular basis.
In this scenario, you precalculate the number of Kanbans you need in a specific period (month) for material RM233-4.
Prerequisites
The Kanban control cycle for material RM233-4 is maintained and independent requirements exist.
[bookmark: unique_22][bookmark: _Toc51216028]Check Dependent Requirement of Material RM233-4
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
In this step, you check whether dependent requirements for RM233-4 exist.
Prerequisite
The independent requirement planning for material FG233 is done and a planning run is finished.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as a Production Planner.
	The SAP Fiori launchpad displays.
	

	2
	Access the App
	Open Monitor Material Coverage - Net / Individual Segments (F2101).
	
	

	3
	Select Material
	Mark the checkbox of the following materials, and then choose Manage Materials at bottom right.
Material: RM233-4
	The Material Details screen displays.
	

	4
	Check the Dependent Requirement
	Review the Dependent Requirement of the material RM233-4, then choose Home.
	You've checked the data available for RM233-4.
	


[bookmark: unique_23][bookmark: _Toc51216029]Release Scheduling Agreement
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
This process step shows you how to release scheduling agreement delivery schedule with forecast schedule.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as a Purchaser.
	The SAP Fiori launchpad displays.
	

	2
	Access the App
	Open Manage Purchase Scheduling Agreements.
	
	

	3
	Find Scheduling Agreement Number
	Find the appropriate scheduling agreement through the search criteria, such as: Supplier 10300002, Agreement Type LPA (SA With Release doc.), Purchasing Organization1010, then choose Go.
	The desired scheduling agreement displays on the Manage Scheduling Agreements list page .
	

	4
	Release of Schedule at Scheduling Agreement Level
	On the Scheduling Agreements list, select the schedule agreement and choose Release in the right upper corner.
Select Release: Forecast and JIT Schedule. In the Release: Forecast and JIT Schedule dialog box, choose Release.
Or
Select Forecast Schedule, in the Release: Forecast Schedule dialog box, choose Release.
And select JIT Schedule, in the Release: JIT Schedule dialog box, choose Release.
In the Release Result Log dialog box, choose Close.
	Release of schedule shall be with green status.
	


[bookmark: unique_24][bookmark: _Toc51216030]Set Available Kanban to EMPTY
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
In this step, you set an available Kanban to EMPTY to trigger the external procurement of RM233-4.
Prerequisite
The Kanban control cycle for material RM233-4 is created.
Procedure
It is possible to change Kanban Container's status using different Fiori apps. You may choose one of them to execute the task in this step (set to EMPTY) and the subsequent steps (for example, set to Full) where applicable. Here we provide two options for you, you can choose either one of them.
Option 1:

	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as a Production Operator - Lean Manufacturing.
	The SAP Fiori launchpad displays.
	

	2
	Access the App
	Open Set Kanban Container Status (F3717).
	
	

	3
	Select the Kanban
	Select a Kanban container on the left part of the screen. Choose Value Help icon to open Select: Barcode window. Choose Show Advanced Search to make following entries and press Enter.
1. Plant: 1010
· Production Supply Area: KANBAN_01
From the Items list, choose one of the Kanban for RM233-4 with Current Status WAIT or FULL.
	The Kanban you entered is displayed.
	

	4
	Check Kanban Information
	On the right part of the screen, check following entry:
Target Status: Empty
	
	

	5
	Set the Kanban to Empty
	On the left part of the screen, choose Save at the bottom.
	Setting an available Kanban to EMPTY creates a JIT (Just In Time) call for material RM233-4.
	



Option 2:
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as a Production Operator - Lean Manufacturing.
	The SAP Fiori launchpad displays.
	

	2
	Access the App
	Open Kanban Board (F4630).
You can find the app under category Production Control - Kanban Monitoring..
	
	

	3
	Search
	Make following entries and search and choose Go:
Plant: 1010
Production Supply Area: KANBAN_01
Material: RM233-4
	
	

	4
	Select Kanban Container
	In the Control Cycle, choose one Kanban Container with Status WAIT or FULL. You can check the legend for description of visual elements.
Container Details panel will display at the right side.You can check detailed information.
	
	

	5
	Set the Kanban to Empty
	Choose Set to EMPTY above the list.
	Setting an available Kanban to EMPTY creates a JIT(Just In Time) call for material RM233-4.
	


[bookmark: unique_43][bookmark: _Toc51216031]Posting the Goods Receipt for External Procurement
Purpose
You can post goods receipt for external procurement either by changing the Kanban container to FULL or by posting GR for JIT call. You can choose one of the options to proceed.
[bookmark: unique_25][bookmark: _Toc51216032]Option A: Change the Kanban to FULL
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
In this step, you change the status of the Kanban you processed in previous step to FULL for material RM233-4.
Prerequisite
The status of the KANBAN is set to EMPTY previously.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as a Production Operator - Lean Manufacturing.
	The SAP Fiori launchpad displays.
	

	2
	Access the App
	Open Set Kanban Container Status (F3717).
	
	

	3
	Select the Kanban
	Select a Kanban container on the left part of the screen. Choose Value Help icon to open Select: Barcode window. Choose Show Advanced Search to make following entries and press Enter.
1. Plant: 1010
· Production Supply Area: KANBAN_01
From the Items list, choose one of the Kanban for RM233-4 with Current StatusEmpty.
	The Kanban you entered displays.
	

	4
	Check Kanban Information
	On the right part of the screen, check following entry:
Target Status: Full
	
	

	5
	Set the Kanban to Full
	On the left part of the screen, choose Save at the bottom.
	Setting the EMPTY Kanban to Full executes a goods receipt in production storage location and a reduction of scheduling line for the amount delivered.
The stock is increased for the Kanban amount.
The scheduling lines are deleted for the delivered amount.
	


[bookmark: unique_26][bookmark: _Toc51216033]Option B: Goods Receipt for JIT Call
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
This process step shows you how to post goods receipt for JIT call. It is useful especially when you want to post partial quantities of individual items of a summarized JIT call, or for more containers at once.
Prerequisite
The status of the KANBAN is set to EMPTY previously.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as a Production Operator - Lean Manufacturing.
	The SAP Fiori launchpad displays.
	

	2
	Access the App
	Open Goods Receipt for JIT Call (PJWE).
	
	

	3
	Input JIT Call Number
	Enter the number of the appropriate production JIT call, and choose Adopt.
JIT Call Number: XXXX
Note If you set the indicator In background, the system automatically executes this goods receipt in background mode.
	
	

	4
	Check Quantity
	On the Goods Receipt for JIT Call: Item Overview screen, check the quantity for which you want to post the goods receipt and change if necessary.
	
	

	5
	Post
	Choose Post GR.
	The system posts the goods receipt.
	


[bookmark: unique_27][bookmark: _Toc51216034]Precalculation of Kanbans for Future Requirements
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
In this step, you precalculate the Kanbans you need for the next period (month).
Prerequisite
The Kanban control cycle for material RM233-4 is created and dependent requirements for material RM233-4 exist.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as a Production Planner - Lean Manufacturing.
	The SAP Fiori launchpad displays.
	

	2
	Access the App
	Open Kanban Calculation (PK07).
	The Create Change Proposal For Kanban Control Cycles screen displays.
	

	3
	Enter the Selection Data
	Make following entries and choose Execute.
1. Plant: 1010
· Definition of period - From Date: <Today's date>
· To date: <Date at least 2 month in future>
· Material: RM233-4
In the dialog box, check if a calculation of the Kanban cycle has taken place.
Choose Continue.
	
	

	4
	Exit
	Choose Home.
	You have created a proposal for future requirements of Kanbans for material RM233-4.
	


[bookmark: unique_28][bookmark: _Toc51216035]Release Proposal of Kanbans Required for Future Period
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
In this step, you check the proposal for future Kanban requirements before you release the proposal.
Prerequisite
You have performed a Kanban calculation and a proposal is available.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as a Production Planner - Lean Manufacturing.
	The SAP Fiori launchpad displays.
	

	2
	Access the App
	Open Check Kanban Calculation Result (PK08N)
	The Initial Screen: Check Results of Kanban Calculation screen displays.
	

	3
	Enter the Selection Data
	Make following entries and choose Enter.
1. Plant: 1010
· Material: RM233-4
	The Check Results of Kanban Calculation (Plant 1010) screen displays.
	

	4
	Check the Result
	If the results are feasible, mark the line and choose More > Edit > Adopt > Next Change > For Selected . The New No. of Kanbans field is filled with the precalculated number.
	
	

	5
	Save
	Choose Save.
	You have accepted the proposal for Kanbans and changed the number of Kanbans in control cycle.
	


[bookmark: unique_29][bookmark: _Toc51216036]Check Changes and Calculation Base in Control Cycle
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
In this step, you check if the changes have been done in control cycle and the details of calculation.
Prerequisite
You have performed a Kanban calculation and released it for material RM233-4.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as a Production Planner - Lean Manufacturing.
	The SAP Fiori launchpad displays.
	

	2
	Access the App
	Open Manage Kanban Control Cycles (PKMC)
	The Manage Kanban Control Cycle screen displays.
	

	3
	Enter the selection data
	Make following entries and choose Data Selection.
1. Plant: 1010
· Supply Area: KANBAN_01
	The Control Cycle Maintenance: Display screen displays.
	

	4
	Check the Field No. of Kanban
	Check if the number of Kanbans calculated is written in the control cycle in No. of Kanban field.
	
	

	5
	Choose Calculation
	Choose Kanban Calculation.
	The Kanban Control Cycle Calculation dialog box displays.
	

	6
	View on Calculation Data
	Make the following entries and choose Enter:
1. Evaluation From: <Today's date>
· Evaluation to: <Date + 2 month>
Check the requirements existing for the material and the results of Kanban calculation
Choose Continue.
Note If the graphic does not display, you can force it to show by choosing Print, then choosing Cancel.
	
	

	7
	Exit
	Choose Home.
	You have verified that the control cycle is adopted according to the calculation results and have checked the details of Kanban calculation.
	


[bookmark: unique_30][bookmark: _Toc51216037]Unlock New Kanbans
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
If Kanbans are created during Kanban calculation release, their statuses are locked. When they are really needed, they have to be unlocked.
Prerequisite
You have released a Kanban calculation where new kanbans are needed.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as a Production Planner - Lean Manufacturing.
	The SAP Fiori launchpad displays.
	

	2
	Access the App
	Open Unlock Kanban Container (PK09).
	The Unlock Kanbans displays.
	

	3
	Enter the Selection Data
	Make following entries and choose Execute.
1. Plant: 1010
· Supply Area: KANBAN_01
· Material: RM233-4
	
	

	4
	Unlock Kanbans
	Mark the Kanbans with a blocked indicator for material RM233-4 and choose Unlock selected Kanbans.
Confirm the message with Yes.
	
	

	5
	Exit
	Choose Exit.
	You have unlocked the new Kanbans for material RM233-4. They are now ready for use.
	


[bookmark: unique_31][bookmark: _Toc51216038]Alert for Delayed Replenishments - Creation of Replenishment Elements / JIT Calls (Optional)
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
In this step, you set more than the maximum allowed number of Kanbans to EMPTY to force the creation of alerting, in which case causes delayed replenishments.
Prerequisite
The Kanban control cycle for material RM233-4 is created.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as a Production Planner - Lean Manufacturing.
	The SAP Fiori launchpad displays.
	

	2
	Access the App
	Open Display Kanbans: Demand View (PK13N).
	The Kanban Board: Demand Source View, Initial Screen displays.
	

	3
	Select the Kanban
	Make following entries and choose Enter.
1. Plant: 1010
· Production Supply Area: KANBAN_01
	The Kanban Board: Demand Source View From XX:XX Time screen displays.
	

	4
	Check the Control Cycle
	Mark the correct line and choose More > Goto > Display Control Cycle . Check the maximum number of empty Kanbans (here is 1).
Choose Back.
	
	

	5
	Set More Kanban to EMPTY
	Select the line of Kanban and choose Set to Empty.
Make sure that there are in total more empty Kanbans than the number checked two steps ago (in this case at least two).
	
	

	6
	Check the Kanban Information
	Double-click the empty Kanban to display the replenishment information.
	
	

	7
	Exit
	Choose Home.
	You have set more than the maximum allowed number of Kanbans to EMPTY. This results in alerts concerning delayed replenishment elements.
	


[bookmark: unique_32][bookmark: _Toc51216039]Alert for Delayed Replenishments - Evaluation of Replenishment Elements / JIT Calls (Optional)
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
In this step, you check the alerts caused by previous step.
Prerequisite
The Kanban control cycle for material RM233-4 is created. Also more than the maximum allowed number of Kanbans have the status EMPTY.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as a Production Planner - Lean Manufacturing.
	The SAP Fiori launchpad displays.
	

	2
	Access the App
	Open Due Kanban Replenishment Elements (PKAL).
	The Delayed Replenishment Elements screen displays.
	

	3
	Check All Delayed Replenishment Elements for Material RM233-4
	Make following entries and choose Execute.
1. Plant: 1010
· Delivery Date: <Tomorrow's Date>
· Trigger Alerts: X
· Material : RM233-4
These alerts are caused by the situation that more than the maximum allowed number of Kanbans has the status EMPTY, for example, the replenishment of the Kanbans listed is delayed or the booking in system hasn't taken place yet.
	The Delayed Replenishment Elements screen displays.
	

	4
	Exit
	Choose Home.
	You have checked the alerts caused by the fact that more than the maximum allowed number of Kanbans has the status EMPTY.
	


[bookmark: unique_44][bookmark: _Toc51216040]Event-driven Kanban: External Processing and PDF Print of Kanban Card
In event-driven Kanban, material provision is not based on a predefined number of Kanbans or a predefined Kanban quantity. Instead, it is based on actual material consumption. The material is not continually provided and replenished at a supply area. It is only replenished when specifically requested. In this case, the material is procured externally with purchase orders.
[bookmark: unique_33][bookmark: _Toc51216041]Create Event-Driven Kanban
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
In this step, you create a Kanban for material RM233-2.
Prerequisite
The control cycle for material RM233-2 is created.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as a Production Planner - Lean Manufacturing.
	The SAP Fiori launchpad displays.
	

	2
	Access the App
	Open Display Kanbans: Demand View (PK13N).
	The Kanban Board: Demand Source View, Initial Screen displays.
	

	3
	Select the Kanban
	Make following entries and choose Enter.
Plant: 1010
Production Supply Area: KANBAN_04
	The Kanban Board: Demand Source View From XX:XX Time screen displays.
	

	4
	Create an Empty Kanban
	Mark the line of RM233-2 and choose More > Edit > Create Kanban .
	The Generate Event-Driven Kanban screen displays.
	

	5
	Enter Details of Kanban
	In the Number of Load Carriers field, enter 1 and choose Enter.
Choose Generate Event-Driven Kaban.
	
	

	6
	Check the Kanban Information
	Double-click the empty Kanban to display the replenishment information and the Purchasing Order.
	
	

	7
	Exit
	Choose Home.
	
	


[bookmark: unique_34][bookmark: _Toc51216042]Variant 1: Set Kanban to FULL
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
In this step, you set a Kanban to full for material RM233-2.
Prerequisite
The control cycle for material RM233-2 is created and one Kanban has the status Empty. The Purchasing Order is released.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as a Production Operator - Lean Manufacturing.
	The SAP Fiori launchpad displays.
	

	2
	Access the App
	Open Set Kanban Container Status (F3717).
	
	

	3
	Select the Kanban
	Select a Kanban container on the left part of the screen. Choose Value Help icon to open Select: Barcode window. Choose Show Advanced Search to make following entries and press Enter.
Plant: 1010
Production Supply Area: KANBAN_04
From the Items list, choose one of the Kanban for RM233-2 with Current Status Empty.
	The Kanban you entered displays.
	

	4
	Check Kanban Information
	On the right part of the screen, check the following entry:
Target Status: Full
	
	

	5
	Set the Kanban to Full
	On the left part of the screen, choose Save at the bottom.
	The Kanban status is changed to FULL, which automatically results in a goods receipt in the storage location.
	


[bookmark: unique_35][bookmark: _Toc51216043]Variant 2: Goods Receipt
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
In this step, you set a Kanban to full for material RM233-2.
Prerequisite
The control cycle for material RM233-2 is created and one Kanban has the status Empty.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as a Warehouse Clerk.
	The SAP Fiori launchpad displays.
	

	2
	Access the App
	Open Post Goods Receipt for Purchasing Document (F0843)
	
	

	3
	Enter Purchase Order
	Enter the purchase order ID and choose Enter.
Purchase Document: <Purchase Order from Create Kanban step>
	
	

	4
	Select Item
	From the Items section, select the goods receipt item to be posted.
Material: RM233-2
Quantity: <Quantity>
	The Post button is activated.
	

	5
	Post
	Choose Post.
	The goods receipt to a purchase order with Kanban indicator automatically results in a status change of the Kanban to Full. This corresponds to the purchase order.
	


[bookmark: unique_36][bookmark: _Toc51216044]Set Available Kanban to EMPTY
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
In this step, you set an available Kanban to Empty. The status change to empty results in an event-driven Kanban process in the deletion of the Kanban.
Prerequisite
The Kanban has the status Full.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as a Production Operator - Lean Manufacturing.
	The SAP Fiori launchpad displays.
	

	2
	Access the App
	Open Set Kanban Container Status (F3717).
	
	

	3
	Select the Kanban
	Select a Kanban container on the left part of the screen. Choose Value Help icon to open Select: Barcode window. Choose Show Advanced Search to make following entries and press Enter.
Plant: 1010
Production Supply Area: KANBAN_04
From the Items list, choose one of the Kanban for RM233-2 with Current StatusFull.
	The Kanban you entered displays.
	

	4
	Check Kanban Information
	On the right part of the screen, check the following entry:
Target Status: Empty
	
	

	5
	Set the Kanban to Empty
	On the left part of the screen, choose Save at the bottom.
	By setting an available Kanban to EMPTY, the Kanban is deleted. No stock changes take place in this step.
	


[bookmark: unique_37][bookmark: _Toc51216045]Repetitive Manufacturing Backflush
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
This step executes multiple activities in a single step, such as finished product goods receipt, backflush of component materials, posting of costs to cost collector and creation of material and journal entries.
Errors can occur in back flushing. For example, there may not be sufficient warehouse stock available or important data, such as the issue storage location may be missing. You then have the following options:
Make corrections immediately in a component overview.
Backlogs are created for the complete requirement quantities of the components with errors.
You can process these backlogs later. If negative stocks are allowed for the material in the storage location, the system posts negative stock quantities in certain circumstances.
Note Goods Movement is 131 for Goods Receipt and 261 for Goods Issue. The Material is FG233 (Finished Product).
Prerequisite
Planned orders must exist.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log on
	Log on to the SAP Fiori launchpad as a Production Operator - Repetitive Manufacturing.
	The SAP Fiori launchpad displays.
	

	2
	Access the App
	Open Confirm Repetitive Manufacturing (MFBF).
	The REM Confirmation - Transaction Variant: None screen displays.
	

	3
	Enter Selection Data
	Make the following entries and choose Enter:
Assembly backflush: X
Make-to-stock:
Planned Order: <Planned order number for FG233 from previous step>
	The system proposes Material and Conf. Qty. Change the Conf. Qty as needed.
	

	4
	Post
	Choose Post with Correction.
Select the production version if prompted.
	
	

	5
	Post
	Choose Post.
	The finished product is received into stock and all components listed in the bill of material are issued from stock.
To view the Material document, log on to the SAP Fiori launchpad as a Warehouse Clerk and open Material Document Overview.
1. Debited Accounts: Credited Accounts
· Cost collector: Consumption
· Inventory: Inventory change
· Inventory - Finished Product: Inventory Change - Production
· Consumption - Raw Materials: Inventory - Raw Materials and semi-finished goods
	


[bookmark: unique_38][bookmark: _Toc51216046]Post Processing List of Error Records
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
To post process backlogs from backflushing, you can use this function to create a list of components that have to be postprocessed.
Prerequisite
Material movements are missing for previous backflush operations.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as a Production Operator - Repetitive Manufacturing.
	The SAP Fiori launchpad displays.
	

	2
	Access the App
	Open Reprocess Goods Movements (COGI).
	The Postprocessing of Error Records from Automatic Goods Movements screen displays.
	

	3
	Enter Selection Data
	Make the following entries and choose Enter:
Plant: 1010
	The system displays a list of all assemblies that correspond to the selection criteria and that have components to be postprocessed. This list is sorted by assemblies and production versions. If you have to correct the components or if you want to check availability, select the appropriate assembly and choose Change Selected Postprocessing Recs. The system displays the components of the selected assembly.
	

	4
	Save
	Review the generated list, then choose Save.
Correct any missing material movement for planned orders processed.
	
	


[bookmark: unique_39][bookmark: _Toc51216047]Review Manufacturing Object Pages
Test Administration
Customer project: Fill in the project-specific parts.

	Test Case ID
	<X.XX>
	Tester Name
	
	Testing Date
	Enter a test date.

	Business Role(s)
	

	Responsibility
	<State the Service Provider, Customer or Joint Service Provider and Customer>
	Duration
	Enter a duration.


Purpose
This process step shows you how to review different object pages available for different roles in the manufacturing process.
Procedure
	Test Step #
	Test Step Name
	Instruction
	Expected Result
	Pass / Fail / Comment

	1
	Log On
	Log on to the SAP Fiori launchpad as a Production Planner.
Note You can use any role in section Roles above.
	The SAP Fiori launchpad displays.
	

	2
	Search Material
	Choose the Search icon in the upper right part of the screen.
Make the following entries and choose Search:
1. Search: <BOM Header Material>, refer to section Master Data, Organizational Data, and Other Data.
	The system displays a list of objects using the selected material.
	

	3
	Display Object
	In the All field, select an object from the dropdown list and choose the Search icon.
	The displaying list of objects is limited to the object type selected. If no object is selected, a message would display instead.
	

	4
	Tailor the Result Display
	Under the search line, choose an icon (for example, filter, display as table, sort and so on) to filter the results list.
	The results list is filtered according to your selections.
	

	5
	Repeat Steps
	Repeat steps 1 to 5 for any other role in this test script and any other object offered in the search function.
	The result list of objects displayed differs by the role you use to log on.
	


[bookmark: d2e4522][bookmark: _Toc51216048]Appendix
[bookmark: unique_45][bookmark: _Toc51216049]Process Integration
The process to be tested in this test script is part of a chain of integrated processes.
[bookmark: unique_46][bookmark: _Toc51216050]Succeeding Processes
After completing the activities in this test script, you can continue testing the following business processes:
	Process
	Business Condition

	BEI - Period-End Closing - Plant (Optional)
	These are executed collectively as a part of month-end closing. For more information on the month-end closing procedure, see the Test Script for Period End Closing General Plant.
1. Month-end closing can only be executed once a month.


[bookmark: d2e4719][bookmark: _Toc51216051]Kanban Status - Status Change/Kanban Signal
[bookmark: unique_47][bookmark: _Toc51216052]Classification of the Processing Status of Kanban Container
The course of Kanban Container processing is controlled and made visible through setting the Kanban Containers to appropriate status. Usually, only the statuses "Empty" and "Full" are used. As a rule, if a material in a Kanban Container has been used and a Kanban Container is then set to "Empty", this Kanban Container status automatically triggers the replenishment process. The source of supply (producer, supplier) receives the signal to fill up the Kanban Container again. When the full Kanban Container arrives back at the demand source (the consumer), the latter sets the Kanban Container to the status "Full" and the goods receipt is posted for the material. Normally, Kanban Container is possible with both statuses "Empty" and "Full".
	Status – Description
	Business Condition

	Waiting – 1
	Indicates that although the material has been consumed, the supply source is not yet to supply any more of it. This status is also set if a new Kanban Container has been created.
If a new Kanban Container has been included in the control cycle and no replenishment has yet been triggered, it has the status "Waiting" and can then be set to "Empty" by the demand source (consumer).

	In Process – 3 / In Transit – 4
	The statuses "In Process" and "In Transit" are set by the supply source (supplier) to inform the demand source (consumer) that the Kanban Containers are either being processed or are in transit.
If you use Kanban Containers with purchase orders, the status of a Kanban Container is automatically set to IN TRANSPORT if an inbound delivery has been generated for the order.

	Full – 5
	The status "Full" is assigned by the demand source (consumer) upon receipt of the container or if the goods receipt has been posted for the kanban. Exception: Decoupling of Status Change and Goods Receipt Posting.

	In Use -6
	The status "In Use" is set by the demand source to inform the supply source which Kanban Containers are currently being emptied. (This status can only be set on the kanban board.)

	Error – 9
	The status "Error" is set only by the system. It is set if an error occurs during the processing of a Kanban Container. This may happen, for instance, if a Kanban Container is set to "Empty" and a purchase order is simultaneously to be created. If the desired vendor is invalid at this time, it does not make sense to resolve the situation in dialog mode here. The status of the Kanban Container is then set to "Error" with an appropriate system message.
If you have specified in Customizing for Kanban that only an error message is to be issued when a certain error occurs, the kanban status is not set to "Error". For more information, see: Error Handling.

	Empty – 2
	The status "Empty" is set by the demand source (consumer) when the kanban quantity has been consumed. Depending on the replenishment strategy, this immediately triggers replenishment.




Typographic Conventions
	Type Style
	Description

	Example
	Words or characters quoted from the screen. These include field names, screen titles, pushbuttons labels, menu names, menu paths, and menu options.
Textual cross-references to other documents.

	Example
	Emphasized words or expressions.

	EXAMPLE
	Technical names of system objects. These include report names, program names, transaction codes, table names, and key concepts of a programming language when they are surrounded by body text, for example, SELECT and INCLUDE.

	Example
	Output on the screen. This includes file and directory names and their paths, messages, names of variables and parameters, source text, and names of installation, upgrade and database tools.

	Example
	Exact user entry. These are words or characters that you enter in the system exactly as they appear in the documentation.

	<Example>
	Variable user entry. Angle brackets indicate that you replace these words and characters with appropriate entries to make entries in the system.

	EXAMPLE
	Keys on the keyboard, for example, F2 or ENTER.
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